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After This Session...
You will be able to answer these questions \

» Why Vitis + Platform can be beneficial?
» What's the architecture of a Vitis platform?
» When should | create a custom platform?

» What are the steps of platform creation?
- What are the changes in Vitis 2021.17

& XILINX.
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All Developers Can Build and Deploy on All Platforms

Build Embedded Enterprise Enterprise Infrastructure Data & Al
Developers Application Developers Developers Scientists
W XILINX
i . VITIS.

Q? 0 ‘

o-d-o

o4O
Deploy

Zynqg-7000 Zynq UltraScale+ MPSoC Alveo Versal ACAPs
& XILINX.
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Vitis Unified Software Platform

Domain-specific TensorFlow
development T % FFmpeg
_ Caffe Partners
environments Genomics
N 3 | » Vitis Al Vitis Video Dalc eics
Vitis accelerated BRAVELIRAER] Math & Linear Quantitative And more
libraries Processing Algebra Finance

Compilers Analyzers Debuggers

Vitis core
development kit [

Xilinx runtime library (XRT)

Vitis target platform
J

On-Premise Deployment Cloud Deployment

& XILINX.

Edge Deployment
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Platform - Kernel Example 1: PCle Platform

gzip

gzip
Kernel

PCle Interface PCle DMA DDR Controller
U200 PCle Platform

& XILINX.
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Platform - Kernel Example 1: PCle Platform

Authentication
x86 App

Authentication
Kernel

PCle Interface PCle DMA DDR Controller
U200 PCle Platform

& XILINX.
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Platform - Kernel Example 1: PCle Platform

Authentication
x86 App

Authentication
Kernel

PCle Interface PCle DMA DDR Controller
U250 PCle Platform

& XILINX.
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Platform - Kernel Example 1: PCle Platform

Authentication
ARM App

Authentication
Kernel

ARM Processor PS-PL AXI Interface PS DDR Controller
ZCU102 Base Platform

& XILINX.
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Platform - Kernel Example 2

Video ISP Kernels

Video Encoding
ARM App

MIPI Interface PS-PL AXI Interfaces HW Video Codec _
Custom Video Platform

& XILINX.
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Platform - Kernel Example 2

Object Detection
ARM App

Video ISP Machine Learning
Kernels Kernels

MIPI Interface PS-PL AXI Interfaces HW Video Codec _
Custom Video Platform

& XILINX.
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Platform - Kernel Example 2

Object Recognition
ARM App

Video ISP Machine Learning
Kernels Kernels

MIPI Interface PS-PL AXI Interfaces HW Video Codec _
Custom Video Platform

& XILINX.
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Platform Common Rules

Platforms Provide Interface to Kernels

Clock, Reset, Interrupt Clock, Reset, Interrupt
Interface 10 (GPIO, SPI, IIC) N/A (PS control) or AXI-MM
Interface IP that needs system driver  AXI-MM or AXI Stream
(EMAC, MIPI)

ARM Processors AXI-MM

DDR Controllers AXI-MM

Non-AXI Interface IP

& XILINX.
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From Traditional Flow to Vitis Platform Flow

Vitis
Flow

Traditional
Flow

Standard Interfaces Dev self-contained app Rapid-grow Ecosystem
Logic I/F, SW I/F Easier to validate Standardized interfaces

. . Isolated, portable Software Programmable
ngher level abstraction Focused, efficient High level abstraction
Reusable Platform More developers

Better containing method Open-source society
Evolve by itself

Advanced Tools
Vitis Analyzer, profiling

RTL IP Reuse IP or designs Evolve Slowly

Reference Designs Xilinx, In-house,
3 party, open sourced

Non-standard
Logic I/F, SW I/F
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Platform Architecture & 2243

Types, Components and Relationship

XILINX.



Vitis Platform Types

Vitis Design = | viispatform | + Application

| |

Data Center Embedded
Platform Platform
Data Center Embedded
Acceleration Acceleration

Platform Platform Customizable

Embedded
Data Center Software

Hybrid Platform Development
4 Platfgrm

& XILINX.
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Platform-based Acceleration Application Development
Embedded Acceleration Use Case

» Platform provides » User develops
- Hardware - Acceleration kernels
- A pre-configured “wrapper” containing I/O, and other - Vitis connects kernels to the platform hardware.

functionality.
- Software (embedded only)

- Software applications
- Control acceleration kernels

- Abootable system with XRT installed - Vitis packages everything to a bootable image.

Hardware Software

Linux

Runtime

Kernel

Module Library

PEM 1O Runtime

PFM IP

Kernel Space User Space

>>16 © Copyright 2021 Xilinx iA Xl LINX



Platform and Application Components

» Platform provides (XPFM) » User develops

- Hardware Platform (HPFM) - Acceleration kernels (XO)
The hardware design including IO definition, IP definition Link Hardware with Platform (XCLBIN)
and interface properties Software applications (ELF)

- Software Platform (SPFM) Package Boot Image (sd_card.img)
Linux domain (Kernel, RootFS with XRT, Sysroot)

Boot Images (BIF, FSBL, PMUFW, U-boot, Device Tree)

Hardware Software

Linux

Runtime

Runtime

-

Kernel
Module

Library

PFM IP

PFM 10

Kernel Space User Space

>> 17 © Copyright 2021 Xilinx
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Two ways to organize software components

» Pack into Platform

Linux Domain

SYSROOT

Boot Components

» Assign with System Project

- RFS, Kernel and SYSROOT can share
among platforms

Linux Domain

Linux Domain

XSA

Boot
Components

XSA
Boot
Components

© Copyright 2021 Xilinx
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Vitis makes designs
simplified with pre-built platforms

XILINX.



Examples for Platform Selection

Evaluation -

Develop/PoC -

Customization -

Learn Vitis Acceleration Flow Xilinx Demo Board
Evaluate Vitis Libraries
Evaluate Vitis-Al Performance

Build Custom Kernel Xilinx Demo Board
Add Custom Kernel to
Acceleration Pipeline

Add Custom IO Interfaces Xilinx Demo Board
Design Final Product Custom Board

© Copyright 2021 Xilinx

Xilinx Pre-built
Platforms

Xilinx Pre-built
Platforms

Custom
Platform
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Start with a Pre-built Platform
MFRIERE SR
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Download Pre-built Vitis Embedded Platforms

» Xilinx Download Center www.xilinx.com/download

Vivado (HW Vitis (SW Vitis Embedded
Developer) Developer) Platforms PetaLinux

& ZCU102 Base 2020.1 (ZIP - 208.01 MB) B ase P I atfo 'm & ZYNQMP common image (TAR/GZIP - 977.56 MB) C ommon I m ag e

« Static HW platform Kernel

MD5 SUM Value : 8bcf744c9¢998f1ec3f9edb7cfd810: R O Ot F S

SYSROOT
Boot Components

MDS5 SUM Value : 20618aa28663fe0e528¢72146483cdee

& ZCU102 Base DFX 2020.1 (ZIP - 220.84 MB) D FX P I atfo rm
° Dyn am |C HW p | atform X ZYNQMP common target licenses and sources (T/

MD5 SUM Value : 2642571f5d406348425a3c08b78e3f11

MD5 SUM Value : 6adb9c8f24d3e8¢2897a0f5c65656!
&, ZCU104 Base 2020.1 (ZIP - 207.93 MB)

MD5 SUM Value : 5f817262507¢81cad5a467428e7c2ce9 L ZYNQMP common sysroot licenses and sources (

MD5 SUM Value : 6d1484b45d34b4aebb7e0d63a84ec
3. ZC706 Base 2020.1 (ZIP-167.88 MB)

& XILINX
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http://www.xilinx.com/download

Install Platforms

» Install Platform » Install Common Image

- Extract to platform search path - extract common image to any path
» Platform Search Path » Install SYSROOT

- [opt/xilinx/platforms - Run sdk.sh: self extracted package

- $XILINX_VITIS/platforms
- SPLATFORM_REPO_PATHS

& XILINX.
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Use a Platform

» GUI » CLI
- v++ compiling and linking options

- V++ -C --platform=<platform_name>

myg 2

- Can be embedded in config file
- Host app cross compile environment
- export SYSROOT=<sysroot_path>
- v++ packaging options

- --package.kernel_image <arg>

i

B~

=

B

=

B
Platfo

<

- --package.rootfs

Example
https://github.com/Xilinx/Vitis-Tutorials
- Getting_Started/Vitis/example/zcul02
- /hw/Makefile

- src/zcul02.cfg

V++ Reference Manual
https://mwww.xilinx.com/html docs/xilinx2021 1/vitis doc/
vitiscommandcompiler.html

© Copyright 2021 Xilinx
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https://github.com/Xilinx/Vitis-Tutorials
https://www.xilinx.com/html_docs/xilinx2020_1/vitis_doc/vitiscommandcompiler.html

Install Additional Software with Package Feed

» What is a package feed? » How to use a package feed?
- Install software packages on-the-fly - Enable dnf in rootfs

- Like apt for Ubuntu, yum/dnf for CentOS _ _ _ _
: - dnfis pre-installed in rootfs of common images
- PetaLinux uses dnf

dnf install git - Set up package feed URL on board
. wget http://petalinux.xilinx.com/sswreleases/
3 What are the beneﬂtsf) rel-v2020/generic/rpm/repos/zynqmp_generic_eg.repo
. . . . cp zyngmp_generic_eg.repo /etc/yum.repos.d/
- Skip PetaLinux rootfs recompilation dnf clean all # Clean dnf Local cache
» Who provides these packages? - More archs are supported: zyng, ev, cg, dr, etc.
- Xilinx hosts pre-compiled packages on - Install packages on board

http://petalinux.xilinx.com _
' - dnf install <package name>

» Which packages are included?
- All packages available with PetaLinux

Doc: UG1393 Using Vitis Platforms

& XILINX.
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https://petalinux.xilinx.com/

Agenda Checkpoint \
N

» Why Vitis + Platform can be beneficial?

» What's the architecture of a Vitis platform?

O

» When should | create a custom platform?
- Base platform usage

» What are the steps of platform creation?

& XILINX.
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Create Embedded
Acceleration Platform
from Scratch

SIEZBRARNIEES

XILINX.



Step O0: Base Bootable Design

Base
Bootable
Design

Update Update Generate Platform
Hardware Software Platform Verification

& XILINX.

© Copyright 2021 Xilinx



Step O0: Base Bootable Design

4

Boot to Linux

Design Methods

© Copyright 2021 Xilinx

Verify PS Configuration
Verify DDR
Verify Peripheral functions

Xilinx boards: Vivado preset and PetaLinux
BSP can be used

Custom boards: Setup pinout and PS
settings according to your board

& XILINX.



Step 1. Update Hardware Design in Vivado

BoBoatlZ&e Update Update Generate Platform
Design Hardware Software Platform Verification

& XILINX.
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Step 1. Update Hardware Design in Vivado

Clock and
Reset

AXI Export
Interfaces Interrupt XSA

& XILINX.
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Step 1: Prepare Hardware Design in Vivado

Clock and
Reset

AXI|
Interfaces

Export
Interrupt XSA

AXI for
Control

AXI for
Memory

& XILINX.
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Step 1. Update Hardware Design in Vivado

Clock and AXI
Reset Interfaces

Export

Interrupt XSA

& XILINX.
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A. Mark Project as Extensible Platform Project

= New Project ™) Settings
Project Type * General
Specify the type of project to create, ' Project Settings Specify values for various settings used throughout the design flow, '
These settings apply to the current project.
General
Simulation
Elaboration Name: #ilin_zeul02_base
@ BIL Project Synthesis Project device: Bl- ZCU102 Evaluation Board (xczufeg-ffubl156-2-a) III
~ You will be able to add sources, create block designs in IP Integrator, generate IP, run RTL analysis, synthesis, Implementation £roj ' ’ 9 “
implementation, design planning and analysis. Bitetroam Target language: | Verilog -
7 . s
|« Do not specify sources at this time S P Default library. wil_defaultiib
[] Project is an extensible Vitis Iatforml .
= | = P Tool Settings Top module name:  xilinx_zcul02_base_wrapper III
Post-synthesis Project Project L opti
You will be able to add sources, view device resources, run design analysis, planning and implementation, IP Defaults anguage Lptions
» ¥Hub Store
Source File Werilog options: verilog_version=Verilog 2001 lz‘
1/0 Planning Project Display Generics/Parameters: lz‘
Do not specify design sources. You will be able to view part/package resources. WebTalk Loop caunt; 1.000 =
Help
Imported Project > Tewt Editor
Create a Vivado project from a Synplify, XST or ISE Project File. I || Project is an extensible Vitis platform I
3rd Party Simulators

Example Project
Create a new Vivado project from a predefined template.

Colors

W

Selection Rules
Shortcuts
Strategies

W

Remote Hosts
Window Behavior

w

fy —
P

© Copyright 2021 Xilinx fA Xl LINX



B. Platform Setup

» Vivado GUI

- Window -> Platform Setup
- Enable the AXI, clock and interrupt resources

Diagram x| Address Editor x| Address Map x| Platform Setup x &
Settings Clock
< AXl Port s ™M
MName Enabled 1D Is Default Proc Sys Reset Status Freque...
w AF clk_wiz_0 (Cloc 0
+  Clock - — )
™ clk_outl ] 0 proc_sys_reset_0 fixed w150 MHz
<~ Interrupt ™ clk_out2 3] 1 proc_sys_reset_1 fixed ~ 300 MHz
™ clk_out3 =] 2 fproc_sys_reset_2 fixed w 75 MHz
™ clk_outd =] 3 {proc_sys_reset_3 fixed ~ 100 MHz
+/ Platform Name — )
™ clk_outs [} 4 {proc_sys_reset_4 fixed «~ 200 MHz
™ clk_outs &3] 5 fproc_sys_reset 5 fixed w400 MHz
™ clk_out7 3] 5 {proc_sys_reset_& fixed «~ 600 MHz
v F ps_e (Zynq UltraScale+ MPS

pl_clko J

© Copyright 2021 Xilinx iA Xl LINX



Platform Block Diagram Example

Mandatory

Block

zyng_ultra_ps e 0 |

AXI Interfaces

maxihpm0_fpd aclk
maxihpm0_|pd_aclk
pl_ps irg0[0:0]

ZYNQ]

UltraSCALE™*

M_AXI_HPMO_FPD +[i
M_AX|_HPMD_LPD 4 [

pl_resetn
pl_clko

Zyng UltraScale+ MPSoC

ps8_0 axi_periph

=
|+ s00_AXI

ACLE

ARESETN L] ?.

S00_ACLK H—=E MOO_AXI +[i

axi_intc_0

SDO_ARESETN giapg
MOO_ACLK

rst_psg8_0_100M

slowest_sync clk I

ext_reset_in bus_struct_reset[0:0]
aL :
mifldebug_sys rst  Interconnect_aresetn[0:0]

dc

locked peripheral_aresetn[0:0]

MOO_ARESETN

AX| Interconnect

+ s_axi
s_axi_aclk

0 s_axi_aresetn
intr[0:0]

irg

AXl Interrupt Controller

DroC sys. resel room

>

Processor System Reset
clk_wiz_0

clk_100m

resetn clk_200m

slowest_sync_clk mb_reset
ext_reset_in bus_struct_reset[0:0]
aux_reset_in peripheral_reset[0:0]
mb_debug sys rst  interconnect_aresetn[0:0]

dem_locked peripheral_aresein[0:0]

clk_inl clk_400m

Processor System Reset
proc_sys_reset_200m

locked

Clocking Wizard

slowest_sync_clk mb_reset
ext_reset_in bus_struct_reset[0:0]
aux_reset_in peripheral_reset[0:0]
mb_debug sys rst  interconnect_aresetn[0:0]

dem_locked peripheral_aresetn[0:0]

Processor System Reset
proc_sys_reset_400m

slowest_sync_clk mb_reset
ext_reset_in bus_struct_reset[0:0]
peripheral_reset[0:0]
mb_debug sys rst  interconnect_aresetn[0:0]
dem_locked peripheral_aresein[0:0]

al_reset_in

Processor System Reset

Clock and

Reset

© Copyright 2021 Xilinx

Interrupt
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Vitis Linked Vector Addition Block Diagram Example

clk_wiz_0

clk_100m

recetn  clk_200m
clk_inl clk_400m
locked

Clocking Wizard

zyna_ultra_ps_e 0

|4+ S AXI_HPO_FPD

-

ihpmo_fpd_ack
maxihpm0_lpd_aclk

saxihp0_fpd_aclk
pl_ps_irg0[0:0]

YNQ™

UltraSCALE*

|_HPMO_FPD 4
|_HPMO_LPD 4

ps8_0_axi_periph

+ SDO_AXI

pl_resetn0
pl_clko

-

ACLK

Zynq UltraScale+ MPSoC

———— ARESETN

krnl_vadd_1

j——— SOO_ARESETN H=H

S00_ACLK Ll |
X

proc_sys_reset_200m

f———— MOD_ARESETN

MOOACLK g il o

MO1_ACLK

|4 =_axi_control

ap_rstn

Iwaco” LS

m_axigmem +
' interrupt fme

axi_ic_zyng_ultra_ps_e_0_S_AXI_HPD_FPD)

MO1_ARESETN

4 s00.AxI
ACLK
ARESETN

A

HE=HE MO0_AXI 4 [i=—d

S00_ACLK

Krnl_vadd (Pre-Production)
slowest_sync_ck mb_reset [= - o - 500 ARESETN giag
ext_reset_in bus,_struct_reset[0:0] jm AXI Interconnect axlintc 0 MOO_ACLK
Q aux_reset_in peripheral_reset[0:0] jm P MO0_ARESETN
~ mb_debug_sys_rst  Interconnect_aresetn[0:0] I - interrupt — |
dem_locked peripheral_aresetn[0:0] T AX| Interconnect
s _axi_aresetn irg »
Processor System Reset intr|31:0]
AX] Interrupt Controller
rst_ps8_0_100M
axi_intc_0_intr_1 interrupt_concat
slowest_sync_clk mb_reset
ext_reset_in bus_struct_reset[0:0] 1n0[0:0]
A aux_reset_in peripheral_reset[0:0] 1n1[0:0]
= mb_debug sys_rst Interconnect aresetn[0:0] 1n2(0:0]
- dem_lecked peripheral_aresetn[0:0] 1n3[0:0]
In4[0:0]
Processor System Reset 1n5[0:0]
proc_sys_reset_100m In6[0:0]
In7[0:0]
slowest_sync_clk mb_reset InB[0:0)
ext_reset_in bus_struct_reset[0:0] 1n8[0:0]
Q aux_reset_in peripheral_reset[0:0] 1n10{0:0)
= mb_debug_sys_rst Interconnect _aresetn[0:0] In11[0:0]
dem_locked peripheral_aresetn[0:0] 1n12{0:0)
In13[0:0]
Processor System Reset In14[0:0]
proc_sys_reset_400m 1n15[0:0] dout(310]
1016[0:0]
slowest_sync_clk mb_reset 1n17[0:0]
ext_reset_in bus,_struct_reset[0:0] In18{0:0]
a aux_reset_in peripheral_reset[0:0] 1n19[0:0]
= mb_debug_sys_rst Interconnect _aresetn[0:0] 1n20{0:0]
dem_locked peripheral_aresetn[0:0] 1n21[0:0]
1n22{0:0]
Processor System Reset 1n23{0:0]
irq_const_tieoff In24[0:0]
In25[0:0]
dout[0:0] In26[0:0)
1n27[0:0] :
Auto-linked
1n28(0:0]
1n30[0:0]
Interrupt
Concat

© Copyright 2021 Xilinx

Auto-linked

kernel
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Platform Block Diagram Example

¥ XIUNX

a VERSAL

ddrd_dimm1_sma_ck O

. |

+

+ pr—
N =
i L=
+

+

+

al_engine_0

il 500 00

ps_noc

{4 so0.ax

i+ 501 Ax

i+ 502 Ax

4 503 AX
S04 AN

Ism:m .NDC.

Im"::o .ﬁ. MO0 A1 o[
e 3 CHO_DORA D |

ackd ._I..

AXI Memory

Interfaces

pl_noc

ackl
e EEEE

ack3
aclkd

acks

AXI NoC (Beta

|—- ackf

AX| NoC (Beta

V.
é_}’

)

) <00_83_ac

Al Engine (Beta

ddrd_dimm1

Clock and

Reset

clic_wizard_0

dk_ou2

dk_outl —oy

axi_smc

{4 sooaa Erl
Bt man OR

ack mEm Mooaa [

aresetn AT

AXl SmartConnect (Pre-Production

axi_intc_0

i s axi

s _owi_ack

ok _inl

di_oud
locked

proc_sys_reset_1

somest_syne_clk i reset
ext_reset_in bus_struct_reset|00]
aux_reset in peripheral_reset]0:0]
mib_debug sys st interconnect_aresetn]0:0]
dom Jocked peripheral_aresetn{00]
J
Processor System Reset [Pre-Production

AX| Interrupt Controller (Pre

5_awi_aresetn
o intr]0:0]

proc_sys_reset_2

sowest_sync_chk mb feset
ex_reset_in bus_struct_reset|00]
Q awx_reset in peripheral_reset]{0:0]
= mb_debug sys_rst  infirconnect_aresetn]0:0]
—=t dom Jocked Jeripheral_aresetn{00]
Processor System RgRet [Pre-Production

<

© Copyright 2021 Xilinx

AXI| Control

Interfaces

sowest_sync_chk mb reset
ext_reset_in bus_struct_reset]0:0]
aux_reset in peripheral_reset|0:0]

mb_debug sys st interconnect_aresetn{0:0]
dcm Jocked penpheral_aresetn{0:0]

essor System Reset (Pre-Production)

& XILINX



Platform Block Diagram Example

wersal_cips_0

v

ry

m_asxd_fipd_aclk
= e gD

FPD_CCLNOC_0 +

ps_noc

PMC_NOC_aX 0 +

FPD_CCINOC_L

NOC_LPD_AXI_O

FPD_CCINOC 2

FPD_CCINOC_3

M_ANI_FPD o
fpd_cdi_noc_axid ok
fpd_cdi_noc_axi2_ok
Ipd_cci_noc_axi3_ck

Ipd_axi_noc_clk
pme_axi_ner_axi0_ck
Ipd_cci_noc_axil_ck
pI0_resetn
gemD_tsu_timer_ont{93:0]
0l ol

XILINX

VERSAL.

ddrd_dimm?1_sma_clk [e—t—

Control, Interfaces & Processing System (Beta)

|— |—= ack2

1 L ackd

1 adks

adkl
[

axi_smc

adk

PL Kernel

Control Path

adkl
aresetn

AX| SmartConnect [Pre-F

axi_intc_0

= ax g

s_awi_aclk

roduction)

ai_engine_0

i s00.00
ackD

Memory Path

Stream Path

Clock / Reset

MODAXIS 4 i

S00_axi_ack

AlEngine [Beta)

5_axi_aresstn
- it 3100

| ackd

VR HLE

internmupt

clk_wizard_0

dkinl  dk ol

proc_sys reset_1

ak_ouz

Kocked

slowest_syne_dk peripheral aresetn]:0] —
e_reset in M reset

& aux_reset in bus_struct_reset{d:0]
gom locked peripheral resetj0:0

o mib_debug_sys st interconnect_ aresetn]0:0]

Frocessar System Reset (Fre-Froduction)

proc_sys_reset_2

showest_syne_dk peripheral_aresetn](:0]
e_reset in mi_reset

¢ chom bocked bus_struct_reset{d:0]
0 aus_rese in peripheral reset{d:0
-l mib_debugy_sys_rst  interconnect_aresetn]0:0]

Processor System Reset (Pre-Production)

proc_sys_reset_3

e _reset in
L dem locked

dk_oud

Clocking Wizard [Bata)

showest_syne_clk
aw_resetin
= mib_debug_sys_rst

A

interconnect_aresetn{0:0]
peripheral aresetn]:0]

mib_reset
Bus_struct_reset](:0]
peripheral reset{d:0

Processor System Reset (Pre-Production)
irq_const_tieaff

adkl

1 adk3
ackb

pl_noc

50204
5004
503 A4
s01_4
sAd
505 A

sy dlkd u » u

i+ soom H=H

MOO_AXI 4
CHO_DDR4 0 +

|| dcir4_dimm1

>

MODIN 4

NOC

Xl NoC [Beta)

axi_intc_0_i

A% NoC (Beta)

tr_1_interrupt_concat

Inl[0:0] dout{31:0] m

In13{0:0]

n24{0:0]

In2810:0]
In5[0:01

In15{0:0]

in2310:0]

In20{0:0]

In31[0:0]

In16{0:0]
29001

In11]0:0]

InE{0:0]

Inlaj0:0]

In2[0:0]

In22[0:0]

In18{0:0]

Ind[0:0]

In2710:0]

In3[0:0]

In25{0:0]

InB[0:0]

In0{0:0]

In7[0:00

In19{0:0]

In30{0:0]

dout{0:0]
n

Constant (Pre-Production)

In10{0:0]

In12[0:0]

in21[0:0]

In1710:01
2001

In26{0:0]

Concat [Pre-Production)



C. Export XSA for Software Design

» Vitis GUI
- Create HDL Wrapper
- Generate Block Diagram
- File -> Export -> Export Platform

Select Platform Type

Select Pre-synthesis

Input platform name and description
Generate XSA

LeJ

Export Hardware Platform

Platform Type

Choose whether this project will be exported as a hardware or hardware emulation
platform.

™ Hardware
"~ The project sources will be used for hardware, and not for hardware emulation.

™ Hardware emulation
"~ The project sources will be used for hardware emulation, and not for hardware.

s Hardware and hardware emulation
"~ The project sources will be used for both hardware and hardware emulation.

~ Combine XSAs
©  Combine a hardware XSA and a hardware emulation XSA into a single XSA,

Cancel
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Step 2. Update Software Environment

Base
Bootable
Design

Generate
Platform

Update
Hardware

Update
Software
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Step 2. Update Software Environment

» Supported Software Environments

Software Environment Supported?

Linux
Standalone
RTOS

Yes
No
Roadmap

» Linux Components Requirements

Linux Component

Linux Kernel
Root FS

Device tree

xrt (zocl)
(xrt-dev)

zocl node
override intc num-intr-inputs to 32

» Device tree example

&amba {
zyxclmm_drm {
compatible = "xlnx,zocl";
status = "okay";

interrupts = <0 4>, <1 4>,
<4 4>, <5 4>, <6
<8 4>, <9 4>, <10
<12 4>, <13 4>, <14
<16 4>, <17 4>, <18
<20 4>, <21 4>, <22
<24 4>, <25 4>, <26
<28 4>, <29 4>, <30

}s
}s

&axi_intc 0 {
x1lnx,kind-of-intr = <0x0>;
x1lnx,num-intr-inputs = <0x20>;
interrupt-parent = <&gic>;
interrupts = <0 89 4>;

};

interrupt-parent = <&axi_intc_0>;

<2

4>,
4>,
4>,
4>,
4>,
4>,
4>,

4>,
<7

<11
<15
<19
<23
<27
<31

<3 4>,

4>,
4>,
4>,
4>,
4>,
4>,
4>,
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Step 2. Update Software Environment

Build from Scratch | Use Common Image |

. » Create PetaLinux Project from XSA | » Download Pre-built Common Image
| petalinux-create -t project --template zyngMP o

petalinux-config --get-hw-description=<XSA DIR> Kernelnnage Image
| : Root File System rootfs.ext4
. » Customize Kernel and RFS
' SYSROOT sdk.sh

petalinux-config -c kernel
- petalinux-config -c rootfs -> Add XRT

~» Update User Device Tree

. » Build Kernel, RFS and device-tree o _
- - sw/prebuilt_linux/user_dts/system-user.dtsi

petalinux-build . .
Use Device tree generator to generate device tree from

) Build SYSROOT XA

petalinux-build --sdk
./images/linux/sdk.sh

v
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Step 3. Generate Vitis Platform

BoBoatlZ&e Update Update Generate Platform
Design Hardware Software Platform Verification
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Step 3. Generate Vitis Platform - Prepare Contents

» Hardware: XSA

» Software
- Boot directory
- BIF and the components used by BIF
- fsbl.elf, pmufw.elf, bl31.elf, u-boot.elf

- SD Card FAT32 directory
- U-boot.scr
- Any other custom files

- Optional Linux components

- Vitis 2021.1 can generate a default BIF
- Example BIF

/* linux */
the_ROM_image:
{

[fsbl config] a53 x64
[bootloader] <fsbl.elf>
[pmufw_image] <pmufw.elf>
[destination_device=pl] <bitstream>
[destination_cpu=a53-0, exception level=el-3, trustzone] <bl3l.elf>
[destination_cpu=a53-0, exception level=el-2] <u-boot.elf>

& XILINX.
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Step 3. Generate Vitis Platform

» Vitis GUI

» XSCT CLI

- New -> Platform Project

- Use XSA that was exported in step 1

- Create Linux domain

- Setup BIF, boot dir and image dir

- Generate platform by clicking build icon

Y oo | -e

'1:3957‘““9"353 rtexas3 - : IpsufcorteanB
e [mm Iz
Descri ption: linux_domain z
e

Sysroot Directory:

QEMU Data:

QEMU Arguments:

PMU QEMU Arguments:

Main| Hardware Specification

platform -name $platform_name -hw
$xsa_path/$platform_name.xsa -out ./$OUTPUT -no-boot-bsp

domain -name xrt -proc psu_cortexa53 -os linux -image
$SW_COMP/src/a53/xrt/image

domain config -boot $SW_COMP/src/boot

domain config -bif $SW_COMP/src/a53/xrt/linux.bif
domain -runtime opencl

platform -generate
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Step 4. Verify the Platform

Base
Bootable
Design

Update Update Generate Platform
Hardware Software Platform Verification
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Step 4. Verify the Platform

» Check platforminfo report

- platforminfo <Platform_NAME>.xpfm

» Run Vector Addition example on this
platform

- Check clock information, memory information - It can be in the same workspace if the platform
are reported as expected

Default Clock Index: ©
Clock Index:
Frequency:
Clock Index:
Frequency:
Clock Index:
Frequency:

2
100.000000
0
200.000000
1
400.000000

Is created in Vitis GUI.

- Set PLATFORM_REPO _PATHS environment
variable to allow Vitis to get the platform if not
working on the same workspace or working
with command line flow.

& XILINX.
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Summary

XILINX.



Review the Platform Creation Flow

BoBoatlZ&e Update Update Generate Platform
Design Hardware Software Platform Verification

& XILINX.
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Reference

» UG1416: Vitis Unified Software Platform User Guide

- https://www.xilinx.com/html_docs/xilinx2021_1/vitis_doc/
- Creating Embedded Platforms in Vitis
- Using Embedded Platforms

» Xilinx Platform Source Code
- https://github.com/Xilinx/Vitis_ Embedded_Platform_Source

» Vitis Platform Creation Tutorial
- https://github.com/Xilinx/Vitis-Tutorial/tree/master/Vitis_Platform_Creation

& XILINX.
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https://www.xilinx.com/html_docs/xilinx2021_1/vitis_doc/create_embedded_platforms.html#rjs1596051748503
https://www.xilinx.com/html_docs/xilinx2021_1/vitis_doc/usingembeddedplatforms.html#mym1591997179666
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